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Physiological Dynamics in Animals and Plants - Laboratory 3 -
Measurement of the Light Dependence of the Dark Reactions

of Photosynthesis

Introduction:

This laboratory is a modified version of an exercise developed by Dr. Diane C.
Robertson, Biology Department, Grinnell College, Grinnell, Iowa  50112.  All of the
exercises developed by Dr. Robertson are available at:

http://www.grinnell.edu/courses/bio/qubitmanual/

Today's physiological phenomenon – The “dark reactions” of photosynthesis:

In the 1950s, Melvin Calvin and his colleagues at the University of California, Berkeley,
used radioactive tracer techniques to follow the fate of carbon dioxide in illuminated
photosynthetic algae (genus Chlorella).  They were able to show that carbon dioxide
became "fixed" onto a five carbon sugar (pentose), ribulose 1,5 bis-phosphate, to form an
unstable, six-carbon intermediate that was split within seconds to two molecules of the
three-carbon compound, 3-phosphoglycerate (PGA).  PGA was then used in reactions
that consumed electrons from NADPH and energy from ATP to produce six-carbon
sugars like glucose and fructose.  As you know, glucose and fructose can be covalently
joined to form sucrose, common table sugar.  The NADPH and ATP consumed in the
dark reactions came from the "light reactions" that you measured last week.  Not all PGA
molecules were used to make glucose and fructose; many PGA molecules were used to
regenerate more of the ribulose 1,5-bis-phosphate required to keep photosynthesis going.
Because this pentose sugar was constantly be replenished to keep the cycle of CO2

fixation going, the process came to be know by various names including the Calvin cycle,
the reductive pentose phosphate pathway (cycle), the photosynthetic carbon reduction
pathway, and the "dark reactions" of photosynthesis. Calvin received the Nobel prize in
1961.

Remember that many textbooks reduce photosynthesis to the following chemical
equation:

6 CO2 + 12 H2O à C6H12O6 + 6 O2 + 6 H2O

Note that photosynthesis consumes CO2, but liberates O2; thus, changes in concentrations
of either gas can be used to measure rates of photosynthesis.  Today, we will measure
rates of net CO2 assimilation (consumption) by illuminated leaves.

Although the carbon fixation reactions are called the "dark reactions" of photosynthesis,
the rate of the Calvin cycle depends on the rate at which the light reactions can supply



2

NADPH and ATP.  Thus, up to a point, the rate of the dark reactions increases with
increasing light levels.

Measure the light dependence of the dark reactions of photosynthesis:

Demonstrate to yourself that leaves assimilate (consume) CO2 at rates that are in direct
proportion to the intensity of light to which they are exposed.  At some point your leaf
may reach a “light saturation point” above which more light will not increase the rate any
further.  At that point, photosynthesis is limited either by the ability of the light to convert
the light energy it absorbs to chemical energy or by the supply of some other factor
required for photosynthesis, such as CO2.  You may then want to determine whether
altering the wavelength (color) of light has an effect on the rate of carbon assimilation.

Step 1 - Read:  Visit http://www.grinnell.edu/courses/bio/qubitmanual/ and read the
“Overview” and “General Setup” sections of the exercise entitled “Measurement of
Photosynthesis using CO2 analyzer.”

Step 2 - Do:  Do the following:

Calibrate the infrared gas analyzer (IRGA):

1) Attach a red flow restrictor to the outlet of the gas pump.

2) Attach a line from the flow restrictor to the drying column containing the blue
Drierite™.

3) Attach a line from the drying column to the inlet of the IRGA.

4) Turn on the pump.

5) Turn on the IRGA; set the switch at 0-500.  Initially the IRGA will read "1"; wait
for it to warm up.  At that time, the numbers on the LED display should drop to
somewhere in the hundreds.

6) Attach a soda lime column (the one containing the white granular material) to the
inlet of the pump.  Using the "coarse zero" first, and then the "fine zero", adjust the
LED on the IRGA to read zero.  You must turn the rheostats with screwdrivers and
then wait some time for the numbers to change.  BE PATIENT!  Do not turn the
rheostats any more until the numbers have stabilized once again.

7) Fill a gas bag from the tank at the side of the lab.  Do not fill it until it is "balloon
tight."  That will compress the gas and produce an artificially high carbon dioxide
concentration in the bag.  The gas is a primary standard which has been mixed to
contain 360 ppm of CO2.  Replace the soda lime column on the pump with the bag.
Wait a couple of minutes for the gas to reach the IRGA, then use the "span" to set
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the reading to 360 ppm.  Your IRGA has now been calibrated.  Unplug the pump
from the multi-outlet strip.

Set up the instruments:

1) Disconnect the drying tube from the pump; run a branched line from the red flow
restrictor connected to the pump outlet to the leaf chamber.  Connect one half of
the branched line to the upper half of the chamber and the other to the bottom half
to provide gas to the chamber.

2) Run a branched line from the top and the bottom halves of the leaf chamber to the
blue Drierite™ drying column to take air out of the chamber.

3) Run a gas line from the drying column to the inlet on the back of the IRGA.

4) Plug the USB cable from the Vernier LabPro into the USB port nearest to you on
the left side of the iBook.

5) Turn on the multi-outlet power strip.

6) Plug in the iBook; turn it on.  (NOTE:  The USB cable from the LabPro must be
plugged in before the iBook is turned on; otherwise, the computer will not "see"
that the LabPro is plugged into the USB port.).

7) Cancel or quit any start up programs (e.g. Norton Antivirus).

8) When the desktop screen appears, launch Logger Pro by double-clicking on the
“Logger Pro alias” icon on the desktop.  If you get this message - "Cannot find the
preferred experiment folder.  Using default experiment folder." - hit OK.

9) Pull down the “Setup” menu and choose "Sensors."

10) Click on the Icon for CH1; Use the pull down menus that pop up to set channel 1
to "CO2 Analyzer"; set calibration to "CO2_500."

11) Click on the Icon for CH2; set channel 2 to "Light Sensor"; calibration =
"W_300qu"; hit OK.

12) Pull down the "View" menu and select "Graph Layout"; select "Two panes"; hit
OK.

13) On the upper graph, click on "Mixed labels"; leave the "CO2 Concentration" box
checked; uncheck the "Med White" box and any other boxes; click OK.
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14) On the lower graph, click on "Mixed labels"; leave the "Med White box checked;
uncheck the Oxygen box and any other boxes; click OK - the upper graph will
display oxygen, the lower one, light intensity.

15) Pull down the Setup menu and choose "Data Collection"; choose "Sampling"; set
the "Time Units" to minutes; set the "Experiment Length" to 120 minutes: set the
"Sampling Speed" to 6 samples per minute; click OK.

16) Click on the "Y" axis of the top graph; set the "Y-axis scale" to a minimum of 280
and a maximum of 400; hit OK.

(NOTE:  If your data go off scale, these values can be changed during data
collection by this same procedure without stopping the sampling; the arrows at the
top and bottom of the Y axis label can also be used to "slide" the scale if your data
go off scale.  As an alternative you can try "Autoscale")

17) Click on the "Y" axis of the bottom graph; set the "Y-axis scale" to a minimum of
0 and a maximum of 300

18) You are ready to collect data.

Experimental:

1) Apply a VERY THIN LAYER of silicon grease to the upper and lower chamber
gaskets.  If they are already greased, don't add any more.  With the light off, seal a
leaf inside the chamber so that no part of the leaf is shaded.  CAREFULLY slide
the leaf in between the upper and lower halves of the chamber; DO NOT TWIST
OR CRIMP THE LEAF PETIOLE.- IF YOU DO YOU WILL SHUT OF THE
WATER SUPPLY TO THE LEAF AND IT WILL DRY OUT AND TURN
BROWN IN YOUR CHAMBER during the experiment.  Adjust the position of the
leaf so that it fills (covers) the entire leaf chamber.  It does not matter if the leaf is
too large to be fully sealed within the chamber.  The excess may protrude out of
the chamber without affecting your results.  When you seal the chamber, turn the
thumb-screws finger tight only; don't crush the leaf!

2) Place a beaker with 200 mL of water on top of the chamber so that it covers the
major part of the leaf area.  This serves as a heat filter; the water should be
changed every 10-15 minutes (have a fresh beaker ready) to prevent heating
(burning) the leaf.  Position the light above the beaker so that its bottom edge is 11
cm from the top of the leaf chamber.

3) Make sure a full gas bag filled from the tank is attached to the pump.  Click on the
"Collect" button at the top of the screen.  The button will change to a "Stop" button
and data will begin to appear on the two graphs on the screen and as numerals on
the bottom of the screen.  The initial "CO2 Concentration" should be around 350-
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550 ppm.; you can watch the exact concentration change on the bottom of the
screen.  Allow the CO2  concentration to stabilize before you proceed.

4) Turn on the light to full intensity.  There will be little change in the CO2 reading
for the first 15-40 minutes of illumination.  REMEMBER - change the water every
15 minutes and WATCH THE GAS BAG - you may want to have a second bag
ready to replace the first one when it becomes depleted.  It will take 15-40 minutes
for the stomata to open.  Once they do, the CO2 concentration in the air flowing
over the leaf will decrease.  Once it does, allow the data collection to proceed until
the CO2 concentration stabilizes.

5) After the CO2 concentration has been stable for 5-10 minutes, lower the light to
about 80% of the initial value; wait for the CO2 concentration to stabilize at its new
value and record another 5-10 minutes of data.

6) Repeat step 5 at approximately 60, 40, 20, 10, and 0 % of the initial light intensity.

7) If you choose, to alter the wavelength (color) of light, start an experiment at full
intensity of white light, then alter the wavelength at maximum intensity by placing
different colored filters over the leaf chamber, under the beaker of water.  Allow
each reading to proceed until a uniform rate is established, usually about 5-10
minutes.  Between filters, turn of the light and change the water.

8) After you have made all of your measurements, click on "Stop" and SAVE YOUR
FILE using "Save as…" in the File menu.  Give your data an appropriate name and
save it to the desktop or your own data folder.

9) Remove the beaker of water, turn off the light.

Step 3 - Analyze data:

The CO2 sensor measures only the partial pressure of CO2 (pCO2) in the gas flowing
through the chamber; it does not measure the rate at which CO2 is consumed.  From your
data you will need to calculate the rate of photosynthesis at each light level used in your
experiment.

1) Open the data file from your experiment.

2) Open the "Analyze" menu and select "Examine."  A vertical line will appear on
your graphs.  You can move the line along the data points on the graph by moving
the mouse.  As you move the vertical line, the numerical display in the box on the
screen will change to show you the exact CO2 concentration, time, and/or light
intensity at the point on the graph where the line is situated.

3) Move the vertical line to the point on your CO2 graph that represents a typical CO2

concentration at the highest light level.  Record the values for CO2 concentration
and light level at that point.
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4) Move the vertical line along the graph to a point that represents a typical CO2

concentration for each of the light levels you tested, recording CO2 concentrations
and light levels at each of those points.

5) Repeat the procedure for any wavelengths data you may have chosen to take.  You
now have all of the data you need to do your calculations.

Step 4 - Calculate:

If you leaf entirely covered the chamber, then the leaf area used to measure
photosynthesis was 0.0009 m2.

The flow rate using the red flow restrictor on the pump is 0.00333 L per second.

1) Calculate the difference between the initial concentration of CO2 in the air flowing
through the chamber before you turned on the light and each experimental CO2

concentration that you measured.  For example, if the initial concentration of CO2

flowing through the chamber just before you turned on the light was 400 ppm, and
the steady-state concentration at the highest light level was 350 ppm, the difference
(∆) is 50 ppm.  Insert your numbers into the table below:

Light level (µmol m-2 s-1) CO2 Concentration (ppm)  (ppm)
Initial dark reading 0

2) Convert each ∆ from ppm to µmoles per liter (µmol L -1) using the following formula:
∆ / {22.413 ([T+C]/T)}

where C is temperature in °C and T is the absolute temperature (273K).  The temperature
of the lab is 23°C.

Example:  At 20°C, a ∆ CO2 of 40 ppm = 1.66 mol L-1.

Record your calculations below:
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Light level (µmol m-2 s-1)  (ppm)  (µmoles per liter)

3) Multiply each ∆ (µmoles per L) for each light level by the flow rate (0.00333 L per
second).  When you do so, the volume units will cancel each other and the units
will become µmol per second (µmol s -1).  Record those values here:

Light level (µmol m-2 s-1)  (µmoles per liter)  (µmoles per liter) x (0.00333
L per second)

4) Express each net CO2 assimilation rate (rate of photosynthesis) at each light level
on a leaf area basis by dividing the CO2 assimilation rate per second (µmol s-1) by
leaf area in the chamber = 0.0009 m2.

Light level (µmol m-2 s-1)   (µmoles per
second)/(0.0009 m2) -

transfer to next column

Net CO2 assimilation rate (µmoles
per second per square meter of

leaf area = µmol m-2 s-1)

Step 5 - Report:

Hand in this lab experiment with the calculations properly executed.

Provide a computer-generated graph of photosynthetic rates in µmol m -2 s-1 on the Y axis
(ordinate) and light intensity (µmol photons m -2 s-1) on the X axis (abscissa).  Label both
axes clearly and correctly with proper units.  Show similar calculations and a graph for
your wavelength data if you collected any.
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Please answer the following questions:

1) Look at the following equation.  According to the equation, during photosynthesis
there is one molecule of oxygen released in photosynthesis for every molecule of
CO2 consumed.

6 CO2 + 12 H2O à C6H12O6 + 6 O2 + 6 H2O

Go back to your data from the experiment in which you measured the light
reactions of photosynthesis and compare those data at similar light levels to
determine whether rates of oxygen production at a given light level approximate
CO2 assimilation rates at similar, or the same, light levels.  You may wish to use
the following table, realizing that light levels will not match perfectly between the
two experiments.

Light level (µmol
m-2 s-1) - First

experiment (Lab 2)
on light reactions
of photosynthesis

Light level (µmol m-2 s-1) -
This experiment (Lab 3)

on dark reactions of
photosynthesis

Net rate of O2

production by
light reactions
(µmol m-2 s-1)

Net CO2 assimilation
rate (µmol m-2 s-1)

Are these values similar or very different?  If they are different, explain why.

2) Aside from the sensors used to measure the gases and the fact that you had to use a
drying column, what is the major difference between the method that you used to
measure O2 production in Lab 2 and the method that you used to measure CO2

uptake in Lab 3?


